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c2Drawing with gCADPlus
This chapter focuses on the use of common drawing tools needed to create typical landscape drawings. You will ‘learn by doing’ and use various draw commands to 
make an accurate, full-size model of a proposal for a space in a garden show. Commands covered include the use of line, polyline, arc and circle commands. Producing 
a complete job such as this, even though it’s for a very small site, will arm you with all the skills necessary to develop designs for much larger sites. 

Since drawing sheets produced by your landscape design studio will contain contact details, logos and site information, as a first step we will ask you to make a sketch 
of a logo and show how to turn it into a CAD drawing. In doing that, we will use gCADPlus’s flexible line (polyline) command and show how useful it can be in 
landscape design work. Once we have made the logo, we’ll move on to the design.

Design for 
fireplace setting 
by
Ross Ubergang
http://www.
rossu.com.au
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A word on landscape logos

A logo is part of the ‘branding’ of every landscape design business. The logo is 
used over and over again in many documents (both in color and black and white), 
so it deserves some thought and testing. 

The logo and information about the site location, direction of north and scale are 
often combined on drawing sheets as shown in the figure below and it is important 
to test the logo in combination with other elements. 

Tip: For even greater efficiency, text information in title blocks is best organized 
as replaceable fields such that inputting details of site location, scale and so on 
becomes a straightforward process.

Design elements in landscape logos

The elements in the logo should reflect the philosophy and aims of your business. 
Some ideas for logos are shown at right. Note that the font chosen has a profound 
influence on the message conveyed.

1.	This design is influenced by a cross-section of a trunk with annual rings.

2.	This design is meant to indicate an abstract fire pit; encouraging outdoor 
entertainment is a specialty of this designer.

3.	This logo for a team of landscape constructors who specialize in brick paving.

4.	An abstract design for a landscaper whose favorite species is the 
Bougainvillea.

Logo and title block combination

1

Logos for landscape designers.

3 4

2
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Tip: Not all logos for landscape companies have to relate to a practice competency. The logo below for a company based in Oregon, USA 
uses a combination of abstract shapes and text and is shown in the gCADPlus drawing editor. The text dominates, with the green color 
used to provide the landscape feel. 

Some more examples of logos for landscape design practices are shown below and to the right.
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Building a CAD version of your own logo

Once you have developed your logo and made a rough sketch, it is useful to have it in several different file formats - as a GIF file for your web site as a high 
resolution TIFF file for printed materials, as a colored CAD file and possibly a version in monochrome (Black & White). All of the above can be generated from one 
gCADPlus drawing file.

The figure in the title block below shows an example of a logo used by a government instrumentality in a rural area of South Australia. Once drawn, there is no need 
to redraw the logo in subsequent plans. It is complex and certainly falls into the category of draw once, use many times. The CAD file of the logo is simply inserted 
into subsequent drawings (as a block, often in a title block). 

Tip: This approach applies other details like north points, furniture, new planting symbols and even to whole designs.

Raster image versions from gCADPlus drawings

This movie shows that raster image files (in GIF, JPEG, PNG form etc.) can be generated from a drawing such as the above and used in documents such as word 
processing notes and brochures.

Logo in  drawing sheet.

http://youtu.be/YggxERnCDTE
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Exercise: Sketch a logo and make a CAD drawing of it 

This movie shows how to trace over a scanned logo for a landscape construction 
company using the polyline command. 

Tip: do not be too fussy about this, you can easily edit the logo later in your 
CAD software application. The steps are:
Scan the logo and save it as a GIF or JPEG file (so it can 
be inserted into a gCADPlus drawing). If you do not have 
access to a scanner, use your phone and email the image to 
yourself.

Start gCADPlus and use the Draw>Insert Raster sequence to 
place the scanned logo in a ‘clean’ gCADPlus drawing on 
layer zero.

Trace over the logo using the Polyline tool. This functions 
much like the line tool that you have used already, but is 
more flexible.

Tip: As shown in the movie, use the smooth tools in the Properties box when the 
polyline is selected. 
Once you have copied the logo, adjust the size of the logo 
using the scale command. Make the logo size approximately 
25 units by 25 units. Wider is ok.

Save the file as a gCADPlus .lcd file (.lcd is the native file 
format for gCADPlus). 

This file will be used in a later exercise when developing a title sheet block.

Tip: If you are tracing a complex image to use as a base for your logo, take 
advantage of gCADPlus layers as shown in the figure at right. Put each part of 
the logo on a different layer.

 A logo in a title block on CAD layout 
sheet.
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Exercise: Create a design for a small space

Let’s imagine that you had been invited to design a pop up installation for a garden 
display show. The figure above right shows an example of the type of installation 
you might have in mind. You saw this design in a Paris park on your recent world 
trip and it has sparked a few ideas!

Brief - illustrate ideas for small garden spaces

The organizers of the show have specified that the space available will be 5 meters 
long by 3 meters wide. When complete, your design will be presented on an A2 
sheet and look something like the one shown in the figure.

 The aim in this exercise is 
to recreate this complete 
design.
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In this exercise, not only will we show how to create the 2D model step-by-step, 
we will build a quick 3D model of the design by exporting to SketchUp and 
produce some images similar to that shown below. 

This movie shows how to produce the design shown above. It uses one of the 
templates available in gCADPlus to speed drafting.

Start gCADPlus. 

Select File>New and choose the template termed ‘Funky’.

This template provides a space on the left of screen to set up the design. The 
symbols on the right can be used  as a ‘drag and drop’ store.
Select the text on the left of screen, right click and 
choose the erase option. This action removes the unwanted 
text leaving the space clear for a design. 

Hold the mouse wheel down and pan to center the view, ready 
to create the design.

First  draw the boundaries of the site ( which measure 5 meters (5000 units - mm) 
by 3 meters. To do that, set a layer as current.
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It is good practice to put boundary information on a 
separate layer. As shown in the movie, click on the layer 
tool and make the layer L-SITE-BOUNDARY layer current. 
This layer was part of the ‘Funky‘ template so there is no 
need to create it again.

Tip: your own templates will contain sets of layer names appropriate to the 
style of work you do. It is suggested that preface each layer with L- to indicate a 
landscape layer. This helps others who subsequently work with our CAD files.

Set a drawing color

For ease of recognition (and only as a temporary step), set the color of the 
boundary layer to red.
Double click on the word ‘Foreground’ in the color column 
and change the color to red as shown below. This means 
that anything drawn on that layer will be red in color.

2. Set a layer for the site boundary.

3. For ease of recognition while tracing, set drawing 
color to red.

1. Erase unwanted text.
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Draw the rectangular base (space) of the display
Select the rectangle tool (choosing the 2 points option) 
from the Draw drop down menu (or toolbar). 

Set the left (first corner of the rectangle at coordinate 
position 0,0 by typing 0,0 in the command area (make sure 
you type zero, not upper case O) 

Hit the ENTER key and the right, second corner of the 
rectangle by typing 5000,3000 and hit ENTER. The result 
should be as shown in the figure.

Place rectangle - select from toolbar 
or Draw drop menu.
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Select the rectangle (with the left button of the mouse) . 
Look in the properties box at left and change the linetype 
scale from 100 to 1.0.

Tip: The Properties box is a most useful check, but it is more than that. If an 
error has been made in typing coordinate values, simply correct the error in the 
Properties box.

The rectangle is now a solid line because the linetype scale has been correctly set.
Select the rectangle again and focus on the size value in 
the properties box. The rectangle must be 5000 units wide 
and 3000 units high and have a center point at X=2500 and 
Y= 1500. If not, you need to start again.

Once the base rectangle is correctly placed, it is time to drag various pieces from 
the template into position as shown in the movie.
Using the Library drop down menu, place some ‘hardscape‘ 
elements such as timber platforms, tables and chairs and 
finally plant symbols into the space. 

Tip: Try to match the ‘feel’ of the symbol to the intended species.

Checking properties of a rectangle.

Create a design by dragging 
symbols into position.
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Create a plant schedule

Every landscape design needs a plant schedule. These can take many different 
forms - individual plants can be tagged with a text indicator, species can be 
identified by their symbol or by the use of the leader command. Experience 
has shown that labeling each plant with a leader is not helpful to the client or 
construction team as the drawing becomes very crowded. A better solution is to 
load a plant list that’s specific for the site involved. Each symbol is tagged and a 
tool on the gCADPlus menu does the rest. The number of each species used in the 
design is counted and a plant schedule (species list) generated. This saves much 
time. 

This function utilizes his a companion database called SppDb. This database 
enables the generation (export) of a plant data list which can be loaded into 
gCADPlus ready for tagging.

This small movie shows how gCADPlus and SppDb work together to produce a 
plant list.

Using a plant data 
file application with 
gCADPlus.

gCADPlus can automatically 
generate the plant schedule.
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Download data file
Visit https://www.designcad.com.au/wp/plant-lists/ and  
download a copy of the file RossPlantlist.gcp and save it to 
your desktop. In the next part of this exercise, you will 
load it into gCADPlus.

Return to your design

Select the gCADPlus drop down menu and the Plant Schedules 
& Lists option and load the downloaded plant list.

Here is a small movie showing how to load a plant list and generate a plant list 
(schedule)
Follow the instructions in the movie to make a plant list. 

1. Attach the plant list. Once attached, the list name will 
show in the status line.

2. Use the “Set data to plant“ tool to lock each of the 
symbols used to a particular species.

3. Use “Show symbols with names“ to check that all symbols 
have been coded.

4. Use “Draw the plant schedule” option, nominating a 
rectangle in which the plant schedule is to be drawn. The 
number of each species used in the design will be totalled. 
If extra symbol copies are added, use the “Update schedule“ 
tool to refresh the list.

Attaching a plant list to a design - 
assign species to symbols.

Generating a plant 
schedule.
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Tip: For an alternative method of identifying a plant symbol, it is possible 
to use the ‘Broadscale’ option on the gCADPlus drop down menu.

Species from the Florida area - photos by Chris 
Maler. A plant list containing landscape species for 
Florida is available on the gCADPlus web site.

The plant schedule displayed 
in layout space.
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Preparing to print

Although it is possible top print a design from model space, drawings are best printed from a separate (layout) space. In this particular drawing, it is possible to move 
to layout space simply by clicking on the tab at the bottom of the drawing editor. This is possible because the template used as a base for the drawing already contains 
a layout space. It has been designed for an A2 sheet, so there is no need to create a new one. The figure below shows the layout view. 

Adding shadows to symbols.
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This movie shows how to manage the layout and printing of the design.

Improving the presentation in Layout space

This movie shows how to improve the presentation of the design.

Add title block and a landscape design logo

This movie shows how to apply shadowing to plant symbols and produce a 
quick PDF version of the design. 
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Additional layouts

In addition to what you have done so far, the client may wish to see:

•	 A section view
•	 Elevations on a layout sheet showing the design for the backing screen with a pattern similar to that on 
the paved surface. 
•	 Location plan
•	 A dimensioned drawing complete with accurate setout point data (on a A4 sheet for a construction 
team to use)

‘Thank you’  wall
Designer: Ross Ubergang. 
www.rossu.com.au
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Section view in model space.

Section view in layout 
space.

Title block and logo added in 
layout space.

Constructing a section view

The tools drop down menu contains a link to a section tool. This can be used as an 
aid to construct both section and elevation views similar to that shown below.

To add interest, an image file - a strip of ‘sky’has been added to the to the layout 
sheet. 

 This movie shows how to use the section tool in a gCADPlus drawing.



gCADPlus User Guide v2.0 73
gCAD+

Elevation view in model 
space.

Elevation view in layout 
space.

Setting up a layout to show 
an elevation view.
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Elevation view

An elevation view is constructed in much the same way 
as the section view. The plant symbol library contains 
some useful symbols although we are sure you would 
prefer to make your own. 

Tip: The images shown here are taken from a an 
alternative design for the same space.
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Return to the design

It is time to draw an elevation view. Landscape designers will often reflect part 
of the building into a landscape plan. However, in this example, that idea has 
been turned on its head. A design for the screen at the back of the plot has been 
made that takes as its main design elements the ‘stripes’ embedded in the paved 
area and applies them to the backing board.

Note that the chairs and tables have not been included here. They will add a lot 
to our elevation once done.

This movie shows how to adjust the shape of a symbol by changing the x scale 
factor.

Edit title block information in layout 
space.

The Print dialog box. When printing to a 
fixed scale, choose print 1:1
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Print (plot) to a fixed scale

There is often a need to plot to a fixed scale. The image below shows another approach to the design task 
described above. The designer wants to plot the drawing out to a fixed scale and then print a check plot on a 
local A4 printer.

Here is a small movie showing how to plot to a fixed scale.
To do that, create a new layout using Format>Layout, choosing an A4 sheet in 

Type an address, fly to the 
site using Google Maps; 
copy the image to the 
drawing.
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landscape view.

Here is the result; the layout has been given a 
meaningful name and the dimension layer turned 
off. Note that the scale factor in the selected floating 
viewport is about 50. 

Let’s assume that only a plan view of the design is 
required, but the scale factor must be fixed. 
Double click into the floating viewport 
and set the display appropriate for 
the plan view.

Here is the result. Note that the scale factor is close to 
20.
To print the design, simply print the 
paper option at a scale of 1=1

Tip: It is recommended that a scale bar be included in 
model space as a separate check on scaling.

Handling title block information
It is better to insert a title block into layout space 
rather than model space. The same block can be 
included on all layout pages, but easily edited to 
adjust information on each sheet while keeping 
the same basic information such as logo and site 
locations.

Apply dimensions in plan view.

Apply dimensions in elevation view using multiple viewports.

This movie shows how to edit title block information 
in layout space.
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Image files

There is often a need to mage files in gCADPlus drawings. These might be used 
to indicate a location plan, design ideas and extended data information. It is very 
convenient to use Google Maps to find a location, save a screen grab as an image 
file and paste the image into gCADPlus. Street names can be included along with 
satellite images to provide a location plan.

Extended entity information.

‘Living chess’ by Ross Ubergang. 
www.rossu.com.au
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Dimensions

Our model is full size and because it has been drawn that way, dimensions can be taken directly from the model with great ease.In order for this to operate smoothly, 
it is  necessary to set up a dimension and a layer to accept the dimensions.

Tip: The layer  L-DIMENSION may already be present in this drawing.

The next step is to create the dimension style and apply the dimensions as shown in the figure below.

This movie shows how to apply dimensions to entities in the drawing.

Provide construction teams with set 
out peg locations.

‘Wood wall’ design by Ross Ubergang. 
www.rossu.com.au
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Applying dimensions to a section

The figure shows some neatly applied dimensions to a 
typical landscape section. [Courtesy of 5SensesDesign]

Here is another movie showing how to apply a set 
of dimensions to an elevation view from a different 
design for the space. 

The figure above right shows another example of well 
applied dimensions. Here the drawing has been plotted 
on an A4 sheet and is not to scale - the dimensions 
themselves take precedence over a written scale.

The presentation of this dimension information can 
be further improved by including a scale bar (as an 
additional check even when a design has been fully 
dimensioned) and utilizing the ability of gCADPlus to 
create multiple floating viewports.

Add lighting design

Providing appropriate lighting is an important part 
of landscape design work. The symbol and location 
can then be passed to programs such as SketchUp in 
order to provide a client with a realistic view of the 
completed design. This movie shows how the divide 
command was used to assist in the location of some 
small up-lights for the rear of the upper platform.

We discuss creation of a lighting design.

This movie shows how the extended data tool can be 
used to improve lighting design information.

‘Herbs’ - design by 
Ross Ubergang. 
www.rossu.com.au
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Add setout points

The point marker tool can be useful to provide a construction team with guidance to set out a complex paved area. See the example below.

This movie shows how to use gCADPlus to assist a construction team layout out an unusual paved area. It uses the Point Marker tool to provide a list of markers for 
pegging the edge of the paving.

Irrigation design

To come.

Export gCADPlus designs to 3D modelers (SketchUp)

Some clients experience difficulty in understanding 2D plans, even when they are provided with elevation and section views. It is of course, possible to hand sketch 
a 3D view, but not everyone has the necessary skill to do that. Many drafters now use software applications such as SketchUp to build a computer generated 3D 
representation of the design.

Tip: SketchUp, a tool previously owned by Google, is now owned by Trimble.

gCADPlus provides a convenient way of exporting base information from a 2D design and bringing it into SketchUp. Building a 3D model is then greatly simplified 
because the accurate 2D information from gCADPlus serves as a base for the 3D model.

You have three options for building a 3D model in SketchUp based on 2D information from gCADPlus:

Example of 3D model in 
SketchUp.



gCADPlus User Guide v2.0 82
gCAD+

(1) Export a graphic and use the free SketchUp application to build a model based on the graphic or

(2) Export a DXF file from gCADPlus and import into free SketchUp (using a plug in to allow DXF importation) or

(3) Use a SketchUp Pro which has the ability to import DXF and DWG files. 

Simple 3D. Build a SketchUp 
model on a JPEG image 
exported from gCADPlus.

Recycled furniture. 
Design: Ross Ubergang. 
www.rossu.com.au
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Option 1

This movie shows how to export a graphic from gCADPlus and use it in 
SketchUp as a base for building a 3D model.

Option 2
Assign a Z value to entities (structural elements) in the gCADPlus drawing. 
Use a “Create SketchUp Layers” tool and export accurate 2D information from 
gCADPlus in the form of a DXF file. Entity snap in SketchUp based on the 
transferred information is then possible.

This movie shows how to work with option (2) in the SketchUp environment. 
Export geometry as a DXF file, import to SketchUp and begin building the 
model.

This movie shows how to pass elevation data to SketchUp.

Assign Z values
Use the layer stack tool and isolate just those entities 
that you want to work with as a base in the SketchUp 
environment (turn off unwanted layers, including the layer 
on which plant symbols have been placed).

Select the Make SketchUp layers tool from the gCADPlus 
drop down menu.

Assign a Z coordinate to entities if required. In the 
example above, the yellow deck was set at 300, the grey 
paved area 100 and the white decoration 105.

Select entities (no hatching, no plant symbols, explode 
blocks if used to make structural details).

Hit Enter.

Choose whether or not to transfer symbols and text to 
another layer.

Start SketchUp and import the DXF file that’s been exported 
from gCADPlus. If you have assigned elevation values to 
each structural entity, it is a simple task to use the 
Push/Pull tool to create 3D geometry.

Use your SketchUp skills to assign materials to surfaces.

Add planting and furniture. An image file taken from the 
elevation view in gCADPlus was pasted onto the screen. 

Add some textures.
SketchUp model based on gCADPlus model.

Assign a Z elevation value to an entity prior to export to SketchUp.



gCADPlus User Guide v2.0 84
gCAD+

If required, the model can be passed to rendering 
software for higher resolution and softening. Note 
the loss of detail of graphic on the screen wall. This 
is a function of the renderer in use. It is possible 
to include the graphic on the rear wall in some ray 
tracing software. 

Some clients may benefit from seeing an animation 
of the proposed design.

Export dwg file from 
gCADPlus.

Export DXF from 
gCADPlus to SketchUp.
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